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INTRODUCTION 

 I am an amateur woodworker and I learned of the free, powerful Computer Aided 

Design (CAD) software named Google SketchUp (GSU) from a woodworking magazine 

I subscribe to.  Since then this wonderful program has come up in almost every 

significant conversation I have had with fellow woodworkers.  It has also been the topic 

of conversation with many architects, machinists, artists, and a wealth of building trades 

people.  It has sparked a marvelous collaboration between regional planners, politicians, 

community groups, college administrators and students as one of my classes works to 

model every major building in our city’s downtown as part of ongoing physical and 

economic redevelopment efforts.   

 Despite the many connections Google SketchUp has spawned in my world, I 

often remain surprised that so few people know about Google SketchUp.  More 

surprising, and indeed somewhat disturbing, is the paucity of mathematics teachers that 

seem to know about Google SketchUp.  At a recent conference only 5 of the 150 

mathematics teachers and researchers knew about it.  In April’s NCTM National Meeting 

there is only 1 session of 827 that involves this tool!  This disturbs me because in 

addition to the rich implications of Google SketchUp to many fields, it can – and I 

believe should – have a profound impact on the way geometry and measurement are 

taught and learned. 

The goals of this paper are three-fold, to provide: 

1)  A brief introduction to Google SketchUp which enables readers with no prior 

knowledge of Google SketchUp or other CAD software to begin using this tool.   



2)  Sufficiently rich examples to illustrate the utility of this Google SketchUp in 

transforming the teaching of geometry and measurement. 

3)  Encouragement and resources that enable teachers to integrate Google SketchUp into 

their teaching of geometry and measurement. 

We believe this will spark many other teachers to develop and share:  their own 

classroom innovations with GSU, additional GSU curricular materials, and research on 

the impact of GSU on learning. 

ABOUT GOOGLE SKETCHUP 

What is Google SketchUp? 

 SketchUp is a powerful, sophisticated, user-friendly Computer Aided Design 

(CAD) program.  (See figures 1 and 2.)  It was developed initially by Last Software in 

2000.  They were acquired by Google in 2006 and the first free version of this software – 

Google SketchUp (GSU) – was released on 27 April, 2006.  GSU is used widely – 

Google 3DWarehouse, an online repository for shared GSU models, already houses tens 

of thousands of models.  It is supported by and integrated with many other Google tools 

that are revolutionizing our use of technology.  For example, any model in Google 3D 

Warehouse, and any model that you build in GSU, can be easily imported into Google 

Earth so it can be seen in its full 3-dimensional glory in its real surroundings.   

Pragmatic Issues that Make Google SketchUp Useful in Education. 

First and foremost, Google SketchUp (GSU) is free.  Not only does this allow 

schools access to powerful software without the hassle of licensing and the budgetary 

issues that are so severe right now, but it also means students can download it and use it 

at home.   



Technically, GSU is robust.  It is supported on PCs and Macs equally.  Download 

times with a cable modem are about 2 minutes.  There are relatively meager hardware 

requirements.  This software has a very gentle learning curve, especially considering its 

remarkable power.  I have worked with 5 and 6 year-olds who show remarkable ability to 

navigate the software to make impressive models with Google Earth. 

A wealth of wonderful tutorial and reference resources are available for every 

technical aspect of using GSU.  Our goal here is to help provide a bridge for its curricular 

integration. 

GOOGLE SKETCHUP – TEACHING, LEARNING AND APPLYING MIDDLE 

SCHOOL GEOMETRY 

 Much of an entire K – 12 geometry and measurement curriculum could be based 

on Google SketchUp (GSU) projects.  In each section here we provide a detailed 

illustration of a project that we invite you to work through on GSU as you read.  We then 

provide a brief summary of an activity you can complete with your students.  We close 

by providing additional resources in this area that are available. 

Many other projects and examples have been developed and are available online 

from our Project PRIME site http://www.wsc.ma.edu/math/prime/ .  We encourage others 

to develop ideas and we will be glad to electronically host materials you would be willing 

to share with others. 

Before beginning, we have a few technical notes.  ESC short circuits your current 

instruction, helping when you realize that you are not doing what you wanted.  Undo on 

the Edit menu is quite useful.  Also, don’t be afraid to just start over.  Last, the 



instructions below are given for PCs.  The only adjustments needed is for Mac users to 

use OPTION instead of CTRL and COMMAND instead of ALT. 

Full 3-Dimensionality 

In contrast to our 3-dimensional existence, our geometry and measurement 

curricula are largely focused on 2-dimensions.  Physical manipulatives like Zome and 

online java scripts help provide opportunities for investigation of 3-dimensional objects, 

but in somewhat rigid ways.  This narrow experience with the mathematics of the space 

we actually inhabits ill equips our students.  In Google SketchUp (GSU) we have, for the 

first time in an accessible form, a tool with the ability to create, transform, represent, and 

analyze 3-dimensional objects of unlimited diversity. 

With GSU students can interact with a world that is as geometrically rich as the 

one we inhabit.  

Illustration:  As shown in figures 3 and 4, to make a prism, proceed as follows: 

1)  Use the Line Tool (the pencil icon on the toolbar) or the Polygon Tool (under the 

Draw menu; click once to set the center, move the mouse, and click again to set the 

“radius”) to make a polygon.  If you use the Polygon Tool and type 8s ENTER it will 

make a octagon.  Similarly for other desired side numbers. 

2)  Activate the Push/Pull Tool (the rectangular box with red up arrow on the toolbar).   

3)  Move the mouse over the polygon.  The face will become speckled, showing that it is 

ready for extrusion. 

4)  Click and drag to extrude polygon into prism.  Release when desired height is 

reached.   

 As show in figures 5 - 7, to make a pyramid, proceed as follows: 



1)  Use the Line Tool or the Polygon Tool to make a polygon. 

2)  Activate the Line Tool and use it to draw lines from each vertex to a desired central 

point of the polygon. 

3)  Select the Move Tool (the icon formed by a pair of intersecting red rays on the 

toolbar). 

4)  Click and hold the central point of the polygon and move it perpendicular to the 

polygon and then release when the desired height is reached.  If you want a right pyramid 

use the built-in inferences which will highlight the coordinate direction as you move. 

5)  Notice that GSU is a surface modeling tool so the pyramid has “lost” its base.  Simply 

redraw one of the sides of the original polygon using the Line Tool and this will re-

complete the face that forms the base. 

Because the Push/Pull Tool always extrudes perpendicular to the cross sectional 

face it is not as direct to make oblique prisms.  One option is described in “Pyramids and 

Prisms” online.     

Once you have made your objects, you should move them around to view them 

from different locations and in different sizes using Orbit (two interlocking circles on 

toolbar), Pan (the hand on the toolbar) to translate, or Zoom (the magnifying glass). 

Student Activity:  In fact, many things around us are really prisms, solids extruded from 

irregular cross sections.  Have students find a number of different prisms of this form in 

the world around them (e.g. cylinders, unsharpened pencils, decorative moldings, lengths 

of gutter, and street curbs).  Then have students build models of these solid objects in 

GSU by using: i) the Line, Arc, and Polygon Tools to make a cross section and then, ii) 

the Push/Pull to extrude.  



Resources:  In “Dimensional Ladder” online we use GSU to both move up the 

dimensional ladder by building and to move down the dimensional ladder using cross 

sections.  In “Dissections” online we give examples of how to use GSU to dissect solids 

and recombine them to form more basic solids as ways of generating volume formulas for 

the initial solids. 

Spatial Abilities 

Because it is so new, little research on the impact of Google SketchUp (GSU) has 

yet appeared in the academic literature.  However, one paper (Dorta, 2008) describes a 

pilot study on the use of GSU to improve the spatial abilities of university level 

engineering students.  Of all the approaches, the use of GSU showed the highest spatial 

ability gains in students.  Yet the development of students’ spatial abilities is our job in K 

-12, especially by during the middle school years where our students are supposed to be 

moving from the more rudimentary geometry and measurement of elementary school in 

preparation for geometry and measurement in high school. 

In some sense, all of the topics touched on in the last section – being able to 

explore the full three dimensions – are critical here as well.  Many of the topics below are 

also relevant to spatial abilities.   

Illustration:  Create a rectangular box and then ruled lines which provide a visceral sense 

of how measurements of surface area and volume come into being as part of the linear 

measuring process. 

1)  Make a rectangular box of integral dimensions.  At each stage in the construction 

process you can simply enter dimensions in the Value Control Box at the lower right.  

(You need do nothing to select this box, all keyboard commands are inserted there 



automatically.)  E.g. 3’,5’ ENTER after drawing a rectangle gives a 3’ by 5’ rectangle 

and then 2’ ENTER after PUSH/PULL gives a 2’ tall extrusion.  This is how the 

rectangular box in figure 8 was created. 

2)  Activate the Tape Measure Tool (in the toolbar). 

3)  Make guidelines to help with ruling the faces.  Click on an edge and then move 

perpendicular to the edge; you will see guidelines drawn.  The distance from the edge to 

the guideline can be set exactly by typing it into the Value Control Box. 

4)  When several guidelines have been drawn, select the Line Tool to draw in the rule 

lines on the faces.  Notice that the rule lines you draw will be highlighted as you move 

parallel to the appropriate coordinate axis so only a small number of guide lines are 

necessary. 

5)  Under Edit you can Delete Guides when completed if you want. 

As you work on this notice how clearly you see the layers that decompose the 

solid into volumes of unit width come into being.  Counting the unit cubes becomes 

innate.  The surface area can then be easily colored (activate the Paint Bucket Tool from 

the toolbar and then activate Colors in the Materials dialog box)  – maybe with different 

colors for different faces. 

You should also utilize the power of having this in 3D – moving around using the 

Orbit Tool, Pan Tool, and Zoom Tool provide powerful visual clues, far superior to any 

static pictures on a board or in a book. 

Student Activity:  Have students create a number of different 3-dimensional objects.  By 

choosing Camera and then Standard Views you can toggle between Top, Bottom, Right, 



Left, Front, Back, and Iso views.  In small groups, have the students guess what they will 

see in the different views before they change their perspective. 

Resources:  The student activity has clear links to the NCTM Illuminations “Isometric 

Drawing Tool.”  Our online “Isometric Cubes” provides a comparable GSU version of 

this tool which now has dramatically increased power because there are no limits to the 

types of objects that are created.  “3D Fractals” shows how to build the Menger Sponge 

and other 3-dimensional fractals.  We feel the crystallographic groups provide an area 

rich for development.  It would be nice to have 3-dimensional analogues of the fine 2D 

GeoMetricks books on tessellations (Roskes and Choate 2008). 

Geometric Modeling 

 This is a key area of the NCTM Geometry Standards.  And it is a natural for 

Google SketchUp (GSU).  You are limited only by your imagination.  In addition to the 

many benefits to students’ geometry and measurement abilities, there are great practical, 

vocational, and motivational benefits here.  The students will be working with the real 

tools of architects, regional planners, engineers, graphic designers and many others. 

Illustration:  Build a basic building. 

1)  Make the building footprint using the Line Tool.  View from the Top to simplify. 

2)  Use Push/Pull to extrude the footprint into walls. 

3)  There many ways to create the roofs.  They can be extruded from gables.  Or, as we 

do here, they can be pulled up from roof ridge lines with the roof faces “Auto Folded”. 

3a)  Use the Line Tool to create edges that will form the roof hips, roof valleys, and roof 

ridges. 



3b)  Use the Select Tool (arrow on the toolbar) to select all of the roof ridges, as shown in 

figure 9.  (Since there are likely more than one, depress CTRL to select multiple 

components.) 

3c)  Activate Move/Copy.  Click ALT to activate Auto-Fold.  Click to Move, insuring 

that you are moving vertically to achieve symmetric roof components, as shown in figure 

10. 

4)  You can make windows, doors, chimneys, steps, and all sorts of other architectural 

details using tools you have already learned.  You can also texture each of the surfaces in 

your model using Paint Bucket and the many texturing components in the Materials 

dialog box. 

Student Activities:  This is exactly what SketchUp was developed for!  There are no 

limits and you’ll be amazed at what your students can do.  In addition to buildings, try 

cell phones, constant companions of students which provide an interesting object for 

modeling.  Soon you will find that those students with computer access at home are even 

modeling on their own – their house, a skateboard park, or a fabulous new invention.   

Resources:  Student and Teacher imagination.  Google 3D Warehouse. 

Transformational Geometry and Symmetry 

 Unlike Tesselmania and other proprietary software for transformational 

geometry, Google SketchUp (GSU) requires the user to actively engage with the 

underlying geometry – not just to make pretty pictures.  GSU has the power to compete 

with most of the transformational geometry software that is widely available. 

Illustration:  Make a Butterfly using Symmetries. 

1)  Make a rectangle. 



2)  Use the Tape Measure to mark two guide points equidistant from the top, right corner.  

(While measuring, the distances can be entered in the Value Control Box.) 

3)  Build the lower, left wing.  Use the Arc Tool (whose icon on the toolbar is an arc) to 

draw three arcs, all inside the rectangle, which, taken together, connect one guide point to 

the other as illustrated by figure 11. 

4)  Delete the unnecessary edges using Erase (the icon shaped like an eraser in the 

toolbar).  Then color the wings by including geometric details and colors.  (E.g. as in 

figure 12.) 

5)  Select the entire wing and activate Make Group from the Edit menu to make the wing 

its own group. 

6)  Rotate a copy to form the upper, left wing.  Activate the Rotate Tool (the icon formed 

by two red arcs forming a circle in the toolbar).  Depress CTRL to indicate you want to 

rotate a copy.  Click on the corner of the wing to set the center of rotation.  As you move 

the mouse you will see a line extending from the center of rotation.  Click again when 

you have formed a line that is horizontal.  This sets the null orientation for your rotation.  

Now moving the mouse will rotate your image, as shown in figure 13.  When the wing 

has been rotated to form the upper, left wing at a 90 degree angle, click to complete the 

rotation. 

7)  Right click on each wing and activate Explode to ungroup the separate wings. 

8)  Select both wings and make them a single group. 

9)  Translate a copy by activating Move/Copy.  Depress CTRL to indicate you want to 

move a copy.  Click and hold mouse on a point on the right edge, move the copy far to 

the right of the other wings and then release, yielding an analogue of figure 14. 



10)  Reflect the right group of wings by activating the Scale Tool from the Tools menu.  

Select the right group by clicking.  You will see a number of “handles” on the edge of the 

group.  Click and hold the mouse on the middle handle on the right edge.  As you move 

to the left the image will shrink laterally.  In fact, it can be shrunk right “through” itself, 

forming a reflected copy, as in figure 15.  Typing -1 ENTER will signal through the 

Value Control Box that you want a reflected image 100% the size of the original. 

11)  Simply translate the reflected image back to the left so the right wings are adjacent to 

the left wings and you have a completed butterfly, as in figure 16.   

 Notice that we have used all of the rigid motions in making the butterfly.  Google 

SketchUp is not limited to two dimensions and transformational tools can be used in 

many 3-dimensional settings. 

Student Activity:  In figure 17 is a portion of the porch railing from the author’s house.  

One piece was modeled and then many copies were placed end to end.  (Simply Copy 

one copy to the end of the original and then type 10x ENTER in the Value Control Box 

and 10 more copies will be spaced end to end.)  Have students design an 3-dimensional 

object that can be appended end to end.  (E.g. railings, fence sections, railroad train cars, 

or row of buildings.)  Then have the students investigate the 3-dimensional symmetries of 

their object using the Move, Rotate and Scale Tools. 

Resources:  All 11 of the wonderful books in the 2D GeoMetricks series (Roskes and 

Choate 2008) provide a wealth of resources in this area.  Online we have “Solids of 

Revolution”. 

BREATH OF GOOGLE SKETCHUP’S POTENTIAL IMPACT ON TEACHING 

GEOMETRY 



 As noted above, Google SketchUp could form the basis of entire K – 12 

curriculum in geometry and measurement.  Now that you have a good idea of how this 

tool works, we would like to highlight some other key areas of application and provide 

some resources. 

Secondary Geometry and Measurement Curriculum 

 The benefits of learning Google SketchUp (GSU) in middle school will pay 

benefits for students as they move through the rest of their formal education as well.  In 

particular, GSU can help provide connections and coherence with the secondary 

curriculum.  A paper similar to this at the secondary level would be appropriate.   

Some main pieces of this are already available through our online resources.  

These include:  “Cross Sections” where the Section Plane Tool is used to find cross 

sections of any GSU object along any plane;  “Conic Sections” where cones are 

constructed and the conics are created using the Section Plane Tool; “Solids of 

Revolution” where lightbulbs, tori, and other beautiful solids are created; “Vertices, 

Edges, and Faces” which allows the dynamic exploration of the relationships between 

these key geometric components which form solids.  Roskes and Choate are working on a 

3D GeoMetricks series which includes instructions on making a huge zoo of solids 

including the Platonic solids, Archimedean solids, and beautiful stellated solids. 

Links to Other Fields 

We have tried to make mention of the myriad ways Google SketchUp connects to 

other fields implicitly throughout.  But the profound impact of this tool in this regard 

cannot be understated.  The tool provides active, substantive, and curricular appropriate 

connections of mathematics to art, architecture, engineering, regional planning, 



construction trades, graphic design, animation, graphics, and many other areas.  Of 

course, this provides wonderful opportunities for collaboration between and among 

students, teachers, and professionals in other subjects, schools, and fields.  The deep 

pedagogical, motivational, and cognitive benefits serve important academic and 

vocational needs of our students. 

Flexibility and Robustness 

Like Geometer’s SketchPad has done for 2-dimensional geometric construction 

and LOGO for basic geometric programming, Google SketchUp (GSU) provides a 

powerful, flexible, and robust tool which will have a long-term impact on technology in 

the teaching of geometry.  GSU can be used in place of many of the narrowly focused, 

inflexible, and proprietary software applications and online scripts.  Special scripts 

animating a knife slicing a cube from a fixed direction?  Use GSU instead for unlimited 

flexibility.  As noted, we have online “Isometric Cubes” and we also have “Pattern 

Blocks” which does not have the mathematical inaccuracies that plague so many online 

scripts in this area.  The potential is unlimited.  The impact is unlimited as well for now 

students will play an active rather than passive role in the underlying geometry that drives 

the technology. 

Technology 

By now we hope that we have brought into focus the impact of Google SketchUp 

(GSU) as a technology that is worthy of our attention.  We’ve seen how it can be 

incorporated into the classroom, suggested how it can deepen students’ mathematical 

understanding, and can enable collaboration across disciplines.   



 In their book The New Division of Labor:  How Computers are Creating the Next 

Job Market (Levy and Murnane 2004), economists Levy and Murnane remind us: 

“Declining portions of the labor force are engaged in jobs that consist primarily of routine 

cognitive work and routine manual labor—the types of tasks that are easiest to program 

computers to do.  Growing proportions of the nation’s labor force are engaged in jobs that 

emphasize expert thinking or complex communication...”  (pp. 53-4) 

The pedagogical benefits of GSU to the teaching of geometry and measurement are 

impressive in their own right.  In addition, people all over the world are using GSU to:  

model existing buildings for everyone to see in Google Earth; design and engineer new 

products; animate views and tours of objects developed in GSU; and spark economic 

redevelopment.  We believe it is part of our job to prepare our students to be part of this 

revolution. 

CONCLUSION 

 We hope the illustrations, examples, and activities above have provided a 

practical introduction to Google SketchUp.  We hope that they have also illustrated the 

profound curricular and pedagogical value of this free, accessible, and important tool.  

What is necessary for the community of mathematics teachers and educators to tap the 

tremendous potential of Google SketchUp is to get it into classrooms and then to share 

the diverse ways in which it nurtures the teaching, learning, and application of 

mathematics.    

We see this article as a first step in encouraging and supporting the use of Google 

SketchUp.  The GeoMetricks series (Roskes and Choate 2008)  provide a wealth of rich, 

beautiful, and valuable mathematical projects for Google SketchUp.  Given the breadth 



and diversity of its potential impact, these resources are clearly only starting points.  We 

invite you and your students to share ways in which can more fully unlock the larger 

potential of this tool.  
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Fig. 1  Columbia Building by Sarah Fulton.  Ms. Fulton was a GSU novice who 

completed this model in just one week of classes after being introduced to GSU. 

 

 



 

Fig. 2  Fractal Stars made by Bonnie Roskes and Jon Choate using GSU. 

 

 



 

Fig. 3  A triangle is… 



 

Fig. 4  …extruded into a triangular prism. 

 



 

Fig. 5  A hexagon becomes… 

 

 



 

Fig. 6  …a right hexagonal pyramid… 

 



 

Fig. 7  …or an oblique hexagonal pyramid. 



 

Fig. 8  A ruled, rectangular box. 

 



 

Fig. 9  Top view of house with lines drawn in for roof hips, valleys, and ridges.  Notice 

ridge lines are selected. 

 



 
 

Fig. 10  Using Push/Pull, with ALT depressed to enable Auto-Folds, creates a roof that is 

both hipped and gabled. 



 

Fig. 11  A butterfly wing. 



 
Fig. 12  Wing colored and formed into a group. 

 



 
 
Fig. 13  A copy of the wing being rotated… 



 
Fig. 14  All four wings after translation of a copy of the left wings.  

 



Fig. 15  Right wings being scaled.  Notice negative VCB reading, the image has been 

reflected and scaled. 

 

 
Fig. 16  Completed butterfly, with antennae added in.   



 

Fig. 17  Author’s porch railing. 

 

 


